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I want all my data in Outlook as accurately as possible.
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1 Welcome

ACT-To-Outlook Professional
2005/2006 Edition

The Ultimate ACT 2005/2006->Outlook Tool!
Never has such a complete and powerful tool been available to

maintain your ACT! 2005/2006 data in Outlook.

Multiple ACT! Users->Multiple Outlook Folder Configurations

ACT! Multi-User Database Outlook 2000, 2002, 2003

A multitude of mixed folder
configurations can be run
simultaneously from ACT! to
Outlook. Users can have individual
or shared Outlook folders!

Compatible with ACT 2005/2006 and Outlook 2000 SR-*, Outlook 2002 and
Outlook 2003!

The purpose of ACT-To-Outlook Professional 2005/2006 Edition is to provide users with a tool to
quickly convert, update, and transfer a multi-user ACT! Contact database into multiple individual or
shared Outlook Folders. Enhanced filtering system and options allow you to slice which segments of
the ACT! database that you want to bring over to Outlook.

Highlights of ACT-To-Outlook Professional 2005/2006 Edition:
· Single Click Multi-User Conversion. Use either our standard field mapping or setup your own

customized field mapping, select which users and their respective Outlook folders and then simply
click on the Convert button to convert all the users.

· Unrivaled ACT! History to Outlook Contact Body Text mapping. Convert all the ACT! history
items to the Outlook contact body text. All of the contact's attachments are brought over and
accessible from within the Outlook Contact form. In addition, every history item's owner is listed
with the text!
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· ACT! Email to Outlook .msg support. Convert ACT! Emails that reside in the history to Outlook
.msg messages.

· Group, Query, Calendar and Ownership support. Filter selected contacts by Group, Query,
Calendar or Ownership to be converted.

· Integrated with Outlook. Closely integrated with Outlook for easy of use and fast conversions. In
addition, you don't get the persistent Outlook security warnings during the conversion.

· Speed. ACT-To-Outlook Professional 2005/2006 Edition is the fastest conversion tool around, in
most cases 2000% faster than the closest rival. Once the first conversion is done, updates are
fast.

· Powerful Activities Options. Activities are converted over and you can tag the activities with a
variety of items that make it ideal for PDA's. Share calendars and more...
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· Share Outlook Task Folders.

· And much, much more....
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2 Introduction

The purpose of ACT-To-Outlook Professional 2005/2006 Edition is to provide users with a tool to
quickly convert, update, and transfer a multi-user ACT! Contact database into multiple individual or
shared Outlook Folders. Enhanced filtering system and options allow you to slice which segments of
the ACT! database that you want to bring over to Outlook.

2.1 Why Use ACT-To-Outlook Professional 2005/2006 Edition

ACT-To-Outlook Professional 2005/2006 Edition is designed for users that have an active ACT!
database and want to transfer data from the ACT! database to the Outlook folders with modifications
that make the data in Outlook more accessible and relevant. In addition, Outlook folder sharing and
intelligent multi-user management makes this product the leading solution to share your ACT! Data
with Outlook.

Major Features
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Ease of Use Install, and you are ready to go. Merge and folder flexibility allows you to keep your
ACT! Contacts updated with your Outlook.

Multi-User
Support

ACT-To-Outlook Professional - 2006 Edition supports ACT! Multi-User
configurations and properly converts the activities relating to all the users enabled
to be converted.

ACT! Versions
Supported

ACT-To-Outlook Professional - 2006 Edition supports ACT! 2005/2006. It does not
support ACT! 2000 or 6.0.

Outlook Versions
Supported

Outlook 2000 SR-* and above, Outlook 2002 and 2003 are all supported.

Field Conversion
Capabilities

All the fields in ACT! can be converted, whether they are standard fields or user
defined fields. In addition, fields that are mapped to Outlook Custom forms are also
converted.

Field Remapping
Capabilities

All fields in ACT! can be remapped to Outlook fields, whether these fields exist in
Outlook or not. The field remapping is maintained if you exit ACT-To-Outlook
Professional 2005/2006 Edition.

ACT! Items
Converted

The following ACT! Items are converted to Outlook equivalents:
· Todo's - ACT! Todo's are converted into Outlook Tasks with the same time-

reoccurring properties.
· Calls - ACT! Calls are converted into equivalent Outlook Calendar.
· Meetings - ACT! meetings are converted into Outlook Calendar.
· History/Notes - All ACT! history items can be converted into the Outlook

contact body text. All attachments and note ownership are converted and can
be viewed in the contact's body text.

· Attachments - Note and History attachments are converted into Outlook
Embedded Attachments that can be viewed directly from the contact body text.

· ACT! Email. ACT! Email is converted into Outlook .msg format (excluding
embedded attachments).

Attachments No longer are attachments lost in the conversion. All attachments are added to the
contact body text where you can see it and open it with the click of a button.

Selective
Conversion

You can choose to convert All, Group, or Calendar.

Group Conversion You can select contacts belonging to an ACT! group and convert only the group.

State-of-the-art
duplicate checking

When you first want to convert your ACT! database into an existing Outlook
contact folder, we check for corresponding contacts according to the following
criteria:

· If it exists on our index database and if it has been transferred to Outlook.
· Email Address.
· First and Last Name and City
· Company Name and City

Outlook Item Move Capability
With our system, you can convert locally and then move the items (contacts,
calendar and tasks) into another Outlook folder with no resulting duplicates when
converting again.

Once the first conversion has been made, ACT-To-Outlook Professional
2005/2006 Edition keeps a 1-to-1 match between the ACT! database and the
corresponding Outlook item so that no duplicates are ever created.
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2.2 Version History

March 15, 2006, Release V 8.2.0.0
General Comments. Continued improvements to the product aimed to enhance support for ACT!-
>Outlook duality. New support for conversion of ACT! email to Outlook .msg is a major step on
maintaining the data consistent between ACT! and Outlook.
Improvements/New Features.

· ACT! Email Support. ACT! Emails attached to a contact's history and notes can be converted into
Outlook .msg equivalents (less any email attachments).

· File As Options. Added the File As options to be able to select just the last name of a contact and
the remainder of the full name. This resolved a lot of filing issues when converting names like First
& Wife Lastname. Much cleaner.

· Outlook Cleaner. Added Outlook Clean where you can remove all the data in Outlook with the click
of a button.

· Improved the Create Outlook Export Folder Tree Tool. More modifications and options were made
available for this great tool.

· Better Help. Improved the help file both online and the help topics.

March 8, 2006, Release V 8.1.6.0
Bug Fix. On certain databases, the software would produce a Memory Overflow when retrieving the
activities from the ACT! database. That is now fixed.

February 26, 2006, Release V 8.1.5.0
General Comments. This product keeps improving to provide the absolute best interface, the fastest
speed and the biggest offering of innovative features. This release added a few more improvements
that we saw lacking on the original release.

Improvements/New Features.
· Secondary Contacts Transfer. We added the capability to transfer secondary contacts. These

contacts come over as user defined properties to the Outlook Contact.
· Sales Opportunities. We now transfer sales opportunities to the contact body text. Quite neat. Get

all the sales info on your Outlook or your PDA/Cell Phone.
· Customizable Sales, Notes, and History headers. You can now customize the headers used to

generate the sales, notes and history lists to anything you want, including a foreign language.
· Improved the Create Outlook Export Folder Tree Tool. This tool keeps getting better. You can

save time and effort by using this fabulous tool.
· Better Help. Improved the help file both online and the help topics.

February 9, 2006, Release V 8.1.0.0
Improvements/New Features.

· International Country Codes. Added support for these
· Enhanced Custom Field generator makes matching and generating custom fields a breeze.
· Create Outlook Export Folder Tree Tool. Improved the tool tree creation to have 3 options. This

reduces folder selection by
· Better Help. Improved the help file both online and the help topics.
· Activity Processing. Added speed and intelligence to activity processing therefore increasing

efficiency by over 1000%.
· Annoyance Reduction Measures. Changed the behavior of password acceptance and storage so

that you only need to enter a password once. Added quick options to the Outlook Clean list so that
you can select all contacts with the click of a button. Added more speed on the outlook cleaning
process. And much more... Over 85 annoyance reduction measures.
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January 6, 2006, New Release V 8.0
This release is compatible with ACT! 2005 and 2006 and can be downloaded directly from the
Download area.

2.3 Help on ACT-To-Outlook Professional 2005/2006 Edition

 You can obtain help for ACT-To-Outlook Professional 2006 Edition in the following ways:

· The help file shipped with the product. The help file provided with ACT-To-Outlook
Professional 2006 Edition is the most recent help file when this version was created. We
provide an online version of this help file which may be more up-to-date than the shipped
version.

· The online help file. This is the most updated version of the help file. When additions and
changes are made to the help file, they are always posted on the online help file. To access the
online help, go to the Help menu on the software.

· Printed Version of this Help File. You can download the made-for-print version of this help file
from the Help menu on the software. You will need to have the Adobe .pdf reader installed on
your system. To download the Adobe .pdf reader, click here. To print the manual, click on the
print button of the .pdf reader and the manual will then be printed on your local printer.

· Email Support. You can obtain free email support from PersonalCRM. Make sure that you
explain your problem/question with as much detail as possible. Use the support form on our
web to contact us at ACT-To-Outlook.com. Click here to submit your problem report.

· Personalized, one-on-one support. ACT-To-Outlook.com will provide personalized, one-on-
one support to paying customers. Support is provided on an hourly basis. If you are interested
on one-on-one support, you can purchase it by clicking here. A support professional will call you
(US Only). If you are based outside the U.S., schedule a time to call so that we can make sure
the best support person is available to receive your call.

· Suggestions. ACT-To-Outlook.com is driven to provide software solutions that will satisfy our
customers. Your input is important to us and we want you to contact us if you have any
suggestions on added features or even improvements we can make to our products in order to
make them better. Please click here to submit a suggestion.

2.4 How to Buy ACT-To-Outlook Professional 2005/2006 Edition

ACT-To-Outlook Professional 2006 Edition is distributed worldwide by a variety of resellers and
distributors.

To Purchase
Click on the Registration->Purchase menu option of ACT-To-Outlook Professional 2006 Edition
and you will be taken to the purchase page for the product.

Home page
http://www.ACT-To-Outlook.com
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3 Installation

Installation of ACT-To-Outlook Professional 2006 Edition is straightforward. The following is needed

· You'll need approximately 60mb of hard disk space if you do not have the .Net framework
installed.

· ACT! 2005 or 2006
· Administrator Privilege if running Windows XP, XP Pro, and 2000

To install, simply execute the ACT-To-Outlook Professional 2006 Edition executable and follow the
directions to install the program.

Once installed, ACT-To-Outlook Professional 2006 Edition is accessed via the Start-
>Programs->ACT-To-Outlook Professional 2006 Edition Menu.

Sub-topics

ACT-To-Outlook Professional 2006 Edition Compatibility
Lists the system with which ACT-To-Outlook Professional 2006 Edition is compatible with.

License Registration
Instructions on the procedures on registering ACT-To-Outlook Professional 2006 Edition

End-User License Agreement

Uninstall

3.1 ACT-To-Outlook Professional 2005/2006 Compatibility

ACT-To-Outlook Professional 2006 Edition is an Addon Product for ACT!. Hence, it requires the
user to have ACT! installed on the machine. ACT-To-Outlook Professional 2006 Edition is ONLY
compatible with ACT! 2005/2006. For versions of ACT-To-Outlook Professional compatible with
other versions of ACT!, come to our web site at ACT-To-Outlook.com.

ACT! 2005/2006 compatibility

ACT-To-Outlook Professional 2006 Edition is compatible with the following versions of ACT!:
ACT! 2005 (7.0), and ACT! 2006 (8.0)

How to find out what version/build of ACT! you are running
To find out what version of ACT! you are running, do the following:

1. Click on Help->About ACT! on the ACT! Contact Screen
2. Check the Build Number on the right hand corner of the About Screen.

Outlook Compatibility
ACT-To-Outlook Professional 2006 Edition is compatible with Outlook 2000 service pack 1 or
higher, Outlook 2002 and Outlook 2003
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Operating System Compatibility
ACT-To-Outlook Professional 2006 Edition is compatible with the following Windows operating
systems:
· Windows 98
· Windows 98 - SE
· Windows Me
· Windows 2000
· Windows XP
· Windows XP Professional

3.2 Registration

Purchasing ACT-To-Outlook Professional 2006 Edition
To purchase ACT-To-Outlook Professional 2006 Edition, click on the Buy/Purchase Button and it
will take you to the web site for purchase. When the product is purchased, you receive a license
code (some of our partners also call it a Serial Number), indicating that your product has been
purchased and paid for.

ACT-To-Outlook Professional 2006 Edition Registration
ACT-To-Outlook Professional 2005/2006 is licensed by the number of users that have an account
in the ACT! database.
The software will not allow you to activate if you have a larger number of users than the
license allows.

When you purchase ACT-To-Outlook Professional 2006 Edition, you are provided with a License
Number (in some cases it is called a purchase serial number). This number is your proof that you
have purchased the product. To activate your product so that it works unencumbered, you need to
enter the license number. You need a valid internet connection in order to activate ACT-To-
Outlook Professional.

To register, click on the Registration ->License Activation Menu Option and you'll get the screen
below:

To activate the product, click on option to which you purchased the license, and you'll get the
screen below:
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To activate, enter the license in the Registration->License Activation screen. This will register your
software with ACT-To-Outlook.com's License Registration Server and enable your product.

The license provided to you will only work on 1 computer. If you attempt to activate the software
on another computer, the license server will not allow that.

ACT-To-Outlook Professional 2006 Edition Registration Problems
To register, ACT-To-Outlook Professional 2006 Edition sends a registration request to a license
server. In some cases, this registration request is blocked by a firewall. You'll get a message like
"Connection was forcibly interrupted" or "Failed to Connect". When such even happens, do the
following:

1. Clink on the Help->Email License Registration

2. Enter the registration details and instructions to activate the product will be sent to you.
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3.3 End-User License Agreement

ACT-To-Outlook Professional 2006 Edition

LICENSE AGREEMENT - ACT-To-Outlook.com Inc.

This is a user license agreement (the "AGREEMENT") between you (either individual or single
entity) and ACT-To-Outlook.com, Inc., for the version of the software (the "SOFTWARE")
accompanying this AGREEMENT.

The SOFTWARE is the property of PersonaCRM, Inc. and is protected by copyright laws and
international copyright treaties.  The SOFTWARE is not sold, it is licensed.

By availing of any of the rights licensed to you in this AGREEMENT, you agree to be bound by and
are becoming a party to this AGREEMENT.  If you do not agree to these terms and conditions, do
not avail of the rights licensed to you in this AGREEMENT.

If you accept the terms and conditions of this AGREEMENT, you have certain non-exclusive rights
and obligations as follow:

YOU MAY do any of the following:
· Use the Software for the Evaluation Period Provided;
· Use the Software for one SINGLE Computer only and for only 1 user;
· Use the Software on a network, PROVIDED that each person accessing the Software through

the network must have a copy licensed to that person or an authorized network multi-user
license.

· Copy the Software for archival purposes ONLY, provided any copy must contain all the original
Software's proprietary notices.

YOU MAY NOT:
· Permit other individuals to use the Software except under the terms listed above;
· Distribute, reveal, post, or disseminate the license key to any other users;
· Permit concurrent use of the Software except with a multi-user license;
· Modify, translate, reverse engineer, de-compile, disassemble (except to the extent applicable

laws specifically prohibit such restriction), or create derivative works based on  the Software;
· Copy the Software other than as specified above;
· Rent, lease, grant a security interest in or otherwise transfer rights to the Software
· Remove any proprietary notices or labels on the Software or its output;

All other rights with respect to the SOFTWARE are reserved. The SOFTWARE is Copyright (c)
2002 ACT-To-Outlook.com, Inc. All Rights Reserved

The Software is provided "AS IS", without a warranty of any kind.

ALL EXPRESS OR IMPLIED CONDITIONS, REPRESENTATIONS AND WARRANTIES,
INCLUDING ANY IMPLIED WARRANTY OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE OR NON-INFRINGEMENT, ARE HEREBY EXCLUDED.  ACT-To-
Outlook.com, INC. AND IT'S LICENSORS SHALL NOT BE LIABLE FOR ANY DAMAGES
SUFFERED BY LICENSEE AS A RESULT OF USING, MODIFYING OR DISTRIBUTING THE
SOFTWARE OR ITS DERIVATIVES. IN NO EVENT WILL ACT-To-Outlook.com, INC. AND IT'S
LICENSORS BE LIABLE FOR ANY LOST REVENUE, PROFIT OR DATA, OR FOR DIRECT,
INDIRECT, SPECIAL, CONSEQUENTIAL, INCIDENTAL OR PUNITIVE DAMAGES, HOWEVER
CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF THE USE OF
OR INABILITY TO USE SOFTWARE, EVEN IF ACT-To-Outlook.com, INC. HAS BEEN ADVISED
OF THE POSSIBILITY OF SUCH DAMAGES.
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ACT-To-Outlook.com, INC. DOES NOT INDEMNIFY ANY PARTY TO THIS LICENSE.

IN ANY EVENT, THE MAXIMUM LIMIT OF ACT-To-Outlook.com, INC.'S LIABILITY UNDER THIS
AGREEMENT IS $1.

ACT-To-Outlook.com, Inc. is not bound by any provision of any purchase order, receipt,
acceptance, confirmation, correspondence, or otherwise, unless  ACT-To-Outlook.com, Inc. is
specifically agrees to the provision in writing.  If any provisions, or portions thereof, of this
agreement are invalid under any applicable statute or rule of law, then that portion shall be deemed
omitted in the applicable jurisdiction and the remaining portions of the agreement remain in force.

3.4 Uninstall

To uninstall ACT-To-Outlook Professional 2006 Edition, do the following:
· Click on Start->Settings->Control Panel
· Execute Add/Remove Programs from the Control Panel
· Select ACT-To-Outlook Professional 2006 Edition from the listed programs
· Click Remove and ACT-To-Outlook Professional 2006 Edition will be removed

from your system.

A Few Things
· Installing and Uninstalling will NOT reset the evaluation period for ACT-To-

Outlook Professional 2006 Edition
· Uninstalling ACT-To-Outlook Professional 2006 Edition will not reset the

conversion counter
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4 Main Interface

ACT! Database and Outlook Profile Details

ACT! Database: This field contains the path to the ACT! database to be converted. Click on the
browse button to select a new database. When a new database is selected, you will be prompted for
Username and Password. The username should be someone that has Administration privileges so
that the software can access the data properly.
Admin Username: This is the name of the ACT! database user authorized to open the database.
Use the Tools->Administration option if you want to change the Administration username.
Outlook Profile: Some users use Outlook profiles to access Outlook. Use the Tools->Administration
options to set/modify the Outlook Profile Name and Password.

User and General Settings Tabs
User Settings Tab: The User Settings Tab provides the list of users as defined in the ACT!
Database and each Tab setting is specific to the user and is only used when the user contacts and
items are converted.
General Settings Tab: The General Settings Tab contains the settings that are applied throughout
the whole conversion of all users.

View and Convert Buttons

View: The View button opens the contact view screen.
Convert: The convert button activates the Conversion Preview screen
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4.1 User Settings

ACT! Username List
Once the ACT! database has been opened, all the users defined on the database are listed. Each
username has it's own set of User Settings. To enable an ACT! user to be converted, you must
check mark the user. Users not check marked are ignored for conversion purposes.

The Password and Folders Tab

In the Outlook Folders Tab, the destination folders where ACT-To-Outlook Professional 2006 Edition
deposits the data are defined.
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With ACT-To-Outlook Professional 2006 Edition you must
which Outlook folder you want to deposit or update the data
from the ACT! 2000/6.0 database. By clicking on the folder
button, the Outlook folder selection form pops up which then
allows you to enter the destination folder(s) for your
conversion.

Make sure that the folder selected matches the type that has
been requested i.e. Contact Folder should be of type Contact
Folder; Appointments folder should be the same as a
Calendar folder, etc..

These folders do not have to reside on your local machine. If
your current version of Outlook can find the folders, ACT-To-
Outlook Professional can find them as well.

Calls and Appointments are deposited into the Outlook
Calendar folder while Todo's are deposited to the Tasks
folder in Outlook.

ACT! Contact Filter Tab

Each user has 5 primary filtering options to convert contacts:
1. Convert All: All the contacts are converted
2. Convert Calendar: Only contacts that have calendar items (calls, meetings or todo's) that are

not cleared are selected.
3. Convert Group: Convert only a selected group and/or subgroups.
4. Do Not Convert Contacts: No contacts are converted for this user.

For more information on Contact Conversion Filters, click here.

Include Private ACT! Contacts. When this option is set, private contacts are included in the
conversion. If unset, no contacts flagged as private are converted to the Outlook Folder.
Match ACT! Record Manager Field for Contacts and Activities. Each ACT! Contact and
Activity has a Record Manager Field. When set, only records that have a record manager ID equal
to the ACT! User being converted are brought over.

Activity Options



ACT-To-Outlook Professional 2006 Edition21

© 2002 - 2007 ACT-To-Outlook.com Inc..

21 

The Activities Options control which activities are converted and how they are modified in Outlook.
Activities To Convert
This converts which activities are converted.

Convert Calls: Enable/Disable the conversion of calls to Outlook
Convert Meetings: Enable/Disable the conversion of calls to Outlook
Convert To Do's: Enable/Disable the conversion of calls to Outlook

Activities Options
Convert Alarms. This option enables the creation of Outlook alarms for ACT! alarms for todo's,
calls, and meetings/appointments. Most ACT! activities tend to have the alarm set but the user has
disabled it via either the snooze button or by some other means. The alarm, however, still lingers
and will pop-up in Outlook as an item to be dealt with. Disabling the conversion of the alarm flag,
you basically do not activate Outlook alarms. If the database is clean and the activities well
maintained, converting alarms should not be a problem. However, if you have lots of old alarms that
have not been dealt with, these alarms will pop up in Outlook with an annoying speed. Hence, we
provide you with the option of converting/not converting the alarms. By default, we do not convert
the alarm.
Include Private Activities. Enable/Disable the inclusion of Private Activities into the conversion.

Subject Line Modification Settings.
The idea of subject line modifications of ACT! activities when transferred to Outlook is to provide
users with additional contact and activity information by simply looking at the activity (meetings, calls
and todo's) subject line. This is very useful when transferring data to a shared calendar or event to a
PDA, since most of the important contact data is included in the activity subject line.

Activity Tags: These are tags that are added in front of the subject line: For example, the word
"Call: " can be added in front of the Call activity being transferred. This word can be edited to
anything you with, for example "Llamada: " if you reside in a Spanish speaking country. Although
this is not so important in the Tasks folder, it is important in the Calendar since it helps users
differentiate between Calls and Appointments.

Modification Options
Modify Calendar: Enable/Disable the modification of Calendar items (Calls/Meetings).
Modify Tasks: Enable/Disable the modification of Tasks items (Todo's).

You can modify and enable/disable the tags that are in front of the subject line to whatever you
want.
Tag Calls: Enable/Disable the tagging of Calls with a specific tag.
Tag Meetings: Enable/Disable the tagging of Meetings with a specific tag.
Tag Todo's: Enable/Disable the tagging of Todo's with a specific tag.

Add Date: Enable/Disable the addition of the activity date.
Add Name: Enable/Disable the addition of the Contact Name with whom the activity is
scheduled with.
Add Company Name: Enable/Disable the addition of the company name.
Add Phone Number: Enable/Disable the addition of the phone number.
Add (Owner): Enable/Disable the addition of the activity owner in parenthesis. This is the name
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of the ACT! username that is the owner of this activity. This feature is useful if you have multiple
uses sharing a single calendar/task folder.

Exclude Modifications with MyRecord Info: When enabled, the logged user's details are not
added to the subject line. This is useful when users have Activities assigned to themselves as
reminders of what to do. Obviously one doesn't want the same name over and over on the tasks
folder. Hence, this option disables the insertion of the

Color matched Example of Subject Line Modifications
Date Added Meeting

Tag
Activity
Owner

Company Contact Name Phone number Subjec
t

10/4/2006 2:19:00 PM Mtng:      (Johnnyt)     CH Gourmet     Allison Mikola,  (212) 555-6743 :: Meet
Re. Sales

Activity Subject Line without subject line modifications enabled: Meet Re. Sales

Email Options
The email options enables/disables the conversion of ACT! .ima emails into Outlook .msg
messages.

· Convert ACT! .ima and .iml Email to Outlook .msg. When enabled, this option convert ACT! .ima
and .iml emails into corresponding Outlook emails so that you can open the email directly from the
Outlook Contact. Note. This option is only valid if the Attachments option is enabled in the general
settings.

· Insert Emails into Contact Body Text. When enabled, the email is inserted into the contact body
text as an icon that can be opened directly from the contact. Currently, this is the only option
available for email processing. However, more options will be available in future releases.

User Notes.
This area is reserved for miscellaneous notes that are pertinent to the user.

4.1.1 How to clear an Outlook Folder Link

In some cases you may want to clear a link to an Outlook folder.
For example, below, we want to clear Mellisa Pearce's link to Allison's Contact Folder.

To clear the link,
1. Click on the folder selection
2. Select the Cancel button
3. Select Yes to clear the Outlook entry from the User Settings.

One thing: Only when the last user has cleared the folder link will the relevant Index maintained by the
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software be cleared. This means, for example, if you have 3 users pointing to the same Outlook folder,
clearing one will not reset the item index for that folder. Only when the last user is disconnected, is the
index reset.

Visual Description on how to clear the Outlook Folder Link

4.1.2 Contact Filters

Contact filters allows users to slice the database and only export the data that is needed.
In all filter settings, the "Include Private ACT! Contacts" and "Match ACT! Record Manager Field for
Contacts and Activities" is applied.
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There are 5 type of filters available:

Convert All
In Convert All, all the contacts in
the ACT! database are
converted to the user's Outlook
Folder.

The Inclusion of Private
Contacts to the matching of the
ACT! Record Manager ID to the
Contacts still apply.

Convert Calendar
In Convert Calendar, only
contacts that have a
corresponding calendar items
i.e. a Meeting, Call or Todo, are
converted over to Outlook.

Note: If the contact folder is not
set, the calendar items are
transferred as independent
items and no contact link is
established.

Convert Group
Select a group to be converted
using the Select Group button
and the group is converted. You
can choose to convert the
subgroups as well.

When To Use: When you only
want to convert a group
(with/without subgroups).

Do Not Convert Contacts
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This option instructs the
software Not to perform any
conversion activity for this user.

When to User: Use this option if
you have multiple users
converting contacts to a single
contact folder and then
converting the activities. If you
are sharing a contact folder,
make sure the contact folder is
set.

4.2 General Settings

The general settings are used for ALL conversions and apply to ALL users.

Field Mapping
The field mapping option allows ACT! fields to be matched to their Outlook equivalent. A preliminary
set of default matches is provided with the software. However, You can either match other ACT! fields
to their "standard" Outlook fields or you can create your own Outlook custom field (please refer to the
section on Adding Outlook Custom Fields for more information on this feature).

To map an Outlook field to an ACT! field
1. Select the ACT! field you want to map to.
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2. Select the corresponding Outlook Field

3. Bring over the match.

Quick Custom Map

The Quick Custom Map is a very easy and effective way of bringing over large number of ACT!
Custom Fields as Outlook custom fields.
It takes the ACT! field and transposes the custom fields to Outlook-Friendly form.

Conversion Options
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Duplicate Found Actions
Clear Duplicate Before Update. When this flag is set, all the data in the contact is cleared before
adding the information to the Outlook Contact.

Force Overwrite of Contacts. When set, all the contacts are forcefully overwritten without regard to
update dates of the contacts in ACT!.

Tag Outlook Item. When set, a tag is added to each item in Outlook. By default, this field is enabled
so that a minimum of duplicate Outlook items are generated and so that you can move Outlook
items to other folders and when you convert again, a positive match is made and no duplicates are
created.

ACT! Groups->Categories Conversion
Convert Groups into Outlook Categories. When enabled, ACT! Groups are consequently
converted into Outlook Categories.
Transfer Secondary Contacts. When enabled, secondary ACT! contacts are converted into
Outlook as User Defined Properties starting with the name Secondary#  where # is the number of
the first contact.

Addressing Options
· Merge Address 1, 2, and 3 into one string. When enabled (default), this option takes the standard

address fields in ACT and merges them into one single string with the fields separated by returns.
This makes the addresses "Outlook friendly". The address fields converted are Address 1,2, and 3
and Home address 1 and 2. Note: you must not map Address 2 and Address 3 in order for this
option to work. Make sure that you have Address 1 enabled. If Address 2 and 3 are mapped, the
address field will be overwritten

· Add phone number extension to Phone number. When set, this option adds the phone number
extension to the end of the phone number. For example, Outlook only provides 1 field to add a
phone number to. Hence, this feature will take the standard phone fields with extensions and put
merge them to make one field in Outlook.

· Add Phone # Country Code. By default, the country code is not added to the Outlook phone
number. However, if you so wish, enable this option and the country code in the format of +CC
(like +44) is added to each Outlook phone number that has a country code.

Ignore Country Code: If a number exists in this box, country codes that match that number are
not brought over to Outlook. This is usefully since most of the time you want to  only bring over
"foreign" country codes but not your own.

· Use Company Name when Name does not exist. Outlook requires a contact name in order for the
links to function properly. This option instructs ACT-To-Outlook Professional 2006 Edition to
replace the company name in the name field of FileAs so that the contact get's saved properly and
links to the contact work well. If this option is not set, the user will be queried for every instance of
this problem.

· File Contact As: This is the string that will be used to file the contact as in Outlook.

One interesting part in the File Contact As selection is that the contact can be saved into Outlook
using the ACT! Firstname and Lastname parameters. However, in our experience, the stored ACT!
Firstname and Lastname are 90% incorrect on an ACT! database. Hence, the option of Force_Last
will take the last string of the name and then it will use the remainder of the contact name as the first
name. The contacts can therefore be Filed As using the formats below:

Company
(Company) Last, First
First Last
Last, First
Last, First (Company)
Last, First - Company
Last, First Company
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Force_Last, Remainder (Company)
Force_Last, Remainder - Company
Force_Last, Remainder  Company

History/Notes Options

The History/Notes options provides the user with the capability to convert the History, Notes and
Attachments that exist in ACT! over to the Outlook Contact Body Text.

Convert Sales Opportunities: When enabled, the contact opportunities are converted. The header
is, by default, "*** SALES OPPORTUNITIES ***". This field can be changed to suit the user.

Convert Notes: When enabled, the notes for the contact are converted. The header is, by default,
"*** NOTES ***". This field can be changed to suit the user.

Convert History: When enabled, history items are converted. The header is, by default, "***
HISTORY ***". This field can be changed to suit the user.

Max History: This number controls the Maximum number of history items to be converted.

Convert Attachments: When enabled, the attachments in the history and notes items are inserted
into the contact's body text.

Ignore Attachments with the Following Extensions: Here you can instruct the software to ignore
any attachment with the extensions provided. By default we provide the IMA and DET
attachments because these are incompatible ACT! attachments and can only be viewed within
ACT!.
Ignore Records With Attachments: When enabled, all records with attachments are ignored.

Add Owner Name: When enabled, the owner's name of the record being converted is added to the
history item.

When Convert History/Notes is enabled, the items enabled on the Notes/History To Convert are
concatenated and inserted into the contact body text as listed below.
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Notes/History Options
Max Number of History/Notes. This is the maximum number of ACT! history/notes to be brought
over. Default is 100.
Add Notes Owner. When enabled, the Notes/History record manager's name is entered at the end
of the date the history was entered into ACT!.

Outlook Forms
Outlook provides the capability to assign a form to a specific contact, calendar and task entry. If you
are using a form that is specific to your application, enter it here.
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4.2.1 Adding Outlook User Defined Fields

Setting up the Outlook User Defined Fields
All Outlook User Defined Fields are displayed in Bold in the User defined field list. ACT-To-
Outlook Professional 2006 Edition allows the user to create corresponding Outlook User defined fields
for ACT! records.

· Add Outlook User Defined Field: add a user defined field to Outlook by simply typing in the
input box. Duplicate fields will be ignored. Also, all fields are considered to be of type string.

· Remove Outlook User Defined Field: remove the selected Outlook user defined property
from the list of defined fields. You can only remove user defined fields.

· Retrieve User Properties from Existing Contacts. If you already have outlook contacts that
have the user defined fields that you want, you can search outlook for these fields using this
option. This option creates a screen that displays all the contacts in the Outlook Contact
Database and when you click on the contact, it will display the user fields defined for that
contact.

By clicking on the contact, this screen displays the user defined fields found for the contact.
Note: if the user defined field has an empty value, Outlook does not see it as a user
defined field and it will not appear in the list!
To add these user fields to the list of user fields that you want to create, select the Add
Outlook User Fields button.
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4.2.2 Outlook Standard Fields

Name Description

Account Specifies the account information

Anniversary Specifies the date of the contact's anniversary

AssistantName The name of the contact's assistant

AssistantTelephoneNumber The telephone number for the contact's assistant

BillingInformation Contains a free-form string that can be used to
hold the billing information associated with the
item.

Birthday The date of the contact's birthday

Body A free-form string containing the body of the
item.

Business2TelephoneNumber The second business telephone number for the
contact

BusinessAddress The entire unparsed business address for the
contact

BusinessAddressCity The city part of the contact's business address

BusinessAddressCountry The country part of the contact's business address

BusinessAddressPostalCode The postal code part of the contact's business
address

BusinessAddressPostOfficeBox The Post Office Box of the contact's business
address

BusinessAddressState The state code for the contact's business address

BusinessAddressStreet The street information for the contact's business
address

BusinessFaxNumber The contact's business fax number

BusinessHomePage The URL of the home web page of the business

BusinessTelephoneNumber The contact's business telephone number

CallbackTelephoneNumber The telephone number at which the contact may
be called back

CarTelephoneNumber The contact's car telephone number

Categories Specifies the categories that are assigned to the
item.

Children The names of the contact's children

Companies A free form string containing the company names
associated with the item

CompanyMainTelephoneNumber The main telephone number for the contact's
company

CompanyName The name of the company that the contact works
for
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Email1AddressType The address type ("SMTP") of the contact's first
email address

Email2Address The contact's second email address

Email2AddressType The address type ("SMTP") of the contact's
second email address

Email3Address The contact's third email address

Email3AddressType The address type ("SMTP") of the contact's third
email address

FileAs The keyword for the contact

FirstName The contact's first name

FTPSite The contact's FTP site entry

FullName The contact's whole name

Gender The gender of the contact

GovernmentIDNumber The government ID number for the contact

Hobby The contact's hobby

Home2TelephoneNumber The second home telephone number for the
contact

HomeAddress The entire unparsed home address of the contact

HomeAddressCity The city part of the home address

HomeAddressCountry The country part of the home address

HomeAddressPostalCode The postal code part of the home address

HomeAddressPostOfficeBox The Post Office Box of the home address

HomeAddressState The state code for the home address

HomeAddressStreet The street information for the home address

HomeFaxNumber The contact's home fax number

HomeTelephoneNumber The home telephone number of the contact

Importance Specifies the importance of the contact (0=low,
1=medium, 2=high)

Initials The initials of the contact

InternetFreeBusyAddress The URL for the contact's free/busy information

ISDNNumber The contact's ISDN number

JobTitle The contact's job title

Journal Specifies whether all the transactions are to be
entered into the journal

Language The language for the contact

LastName Specifies the contact's last name



ACT-To-Outlook Professional 2006 Edition33

© 2002 - 2007 ACT-To-Outlook.com Inc..

33 

MailingAddress The entire unparsed mailing address of the
contact

MailingAddressCity The city part of the mailing address

MailingAddressCountry The country part of the mailing address

MailingAddressPostalCode The postal code part of the mailing address

MailingAddressPostOfficeBox The Post Office Box of the mailing address

MailingAddressState The state code for the mailing address

MailingAddressStreet The street information for the mailing address

ManagerName The name of the manager of the contact

MiddleName The middle name of the contact

Mileage Mileage record for the contact

MobileTelephoneNumber The contact mobile phone number

NetMeetingAlias The contact's ID or alias for Net Meetings

NetMeetingServer The name of the server to host the Net Meeting

NickName The contact's nickname

OfficeLocation The office location information for the contact

OrganizationalIDNumber The organizational ID number for the contact

OtherAddress The entire, unparsed for of another address for
the contact

OtherAddressCity The city part of the other address

OtherAddressCountry The country part of the other address

OtherAddressPostalCode The postal code part of the other address

OtherAddressPostOfficeBox The Post Office Box part of the other address

OtherAddressState The state code for the other address

OtherAddressStreet The street information for the other address

OtherFaxNumber Another Fax Number for the contact

OtherTelephoneNumber Another Telephone Number for the contact.

PagerNumber The contact's pager number

PersonalHomePage The URL for the contact's personal home page

PrimaryTelephoneNumber The primary phone number for the contact

Profession The profession for the contact

RadioTelephoneNumber The radio telephone number of the contact
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ReferredBy The name of the person that referred this contact
to you.

Sensitivity Specifies the level of sensitivity for the contact
(0=normal, 1=personal, 2=private,
3=confidential)

Spouse The name of the contact's spouse

Subject Contains the subject of the item

Suffix The contact's suffix

TelexNumber The contact's telex number

Title The contact's Title

TTYTDDTelephoneNumber The TTY/TDD telephone number for the contact

User1 The first MS Schedule+ user for the contact

User2 The second MS Schedule+ user for the contact

User3 The third MS Schedule+ user for the contact

User4 The fourth MS Schedule+ user for the contact

UserCertificate The authentication certificate for the contact

WebPage The URL for the contact's web page

YomiCompanyName The Japanese phonetic rendering of the company
name

YomiFirstName The Japanese phonetic rendering of the contact's
first name

YomiLastName The Japanese phonetic rendering of the contact's
last name
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4.2.3 ACT! Standard Fields

Database

schema name Field name Description

ADDR1 Address 1

("Address"
displays)

First line of the contact's primary
address.

ADDR2 Address 2

Second line of the contact's
primary address. This field is
spliced with ADDR1

ADDR3 Address 3 Third line of the contact's primary
address. This field is spliced with
ADDR1

ALT1REACH 2nd Last Reach

(not displayed
unless added in
the Layout
Designer)

Date of the last completed call
to the second contact. The
format is YYYYMMDD. This
field is supplied by the system.

ALT2REACH 3rd Last Reach

(not displayed
unless added in
the Layout
Designer)

Date of the last completed call
to the third contact. The format
is YYYYMMDD. This field is
supplied by the system.

ALTADDR1 Home Address 1 First line of the contact's home
address.

ALTADDR2 Home Address 2 Second line of the contact's
home address.

ALTCITY Home City City in the contact's home
address.

ALTCOUNTRY Home Country Country in the contact's home
address.

ALTEXT Alt Phone Ext.

("Ext." displays) Extension for the contact's
alternate phone number.

ALTPHONE Alt Phone Contact's alternate phone
number.

ALTSTATE Home State State in the contact's home
address.

ALTZIP Home Zip Zip code in the contact's home
address.

ASSISTANT Assistant Name of the contact's assistant.

ASST_EXT Asst. Phone Ext.

("Ext." displays) Extension for the phone number
of the contact's assistant.

ASST_PHONE Asst. Phone Phone number of the contact's
assistant.

ASST_TITLE Asst. Title Title of the contact's assistant.

CITY City City in the contact's address.

COMPANY Company Contact's company name.

CONT_TYPE Contact Type Contact record type.

Values are:
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CREATOR Record Creator The database user who created
the contact record. This field is
supplied by the system.

CTIME Create Timestamp

("Create Date"
displays)

Date and time the contact
record was created. This field is
supplied by the system and
stored in a compressed format.

DEPARTMENT Department Contact's department.

ETIME Edit Timestamp

("Edit Date"
displays)

Date and time the contact
record was last modified. This
field is supplied by the system
and stored in a compressed
format.

EXT Phone Ext.

("Ext." displays) Extension for the contact's
primary phone number.

FAX Fax Contact's fax number.

FAX_EXT Fax Ext.

(not displayed
unless added in
the Layout
Designer)

Extension for the contact's fax
number.

FNAME First Name

(not displayed
unless added in
the Layout
Designer)

Contact's first name. This field
is parsed by the system from
the contact.

HOME_PHONE Home Phone Contact's home phone number.

IDSTATUS ID/Status Category assigned to the
contact.

LAST_ATMPT Last Attempt Date of the last attempt to call
the contact. The format is
YYYYMMDD. This field is
supplied by the system.

LAST_MEET Last Meeting Date of the last meeting with the
contact. The format is
YYYYMMDD. This field is
supplied by the system.

LAST_REACH Last Reach Date of the last completed call to
the contact. The format is
YYYYMMDD. This field is
supplied by the system.

LAST_RSLTS Last Results Comments on the last results
with the contact.

LNAME Last Name

(not displayed
unless added in
the Layout
Designer)

Contact's last name. This field is
parsed by the system from the
contact name.

LTTR_DATE Letter Date Date of the last letter sent to the
contact. The format is
YYYYMMDD. This field is
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PAGER Pager Contact's pager number.

PHONE Phone Contact's primary phone number.

PHONE2 2nd Phone Second contact's phone number.

PHONE2_EXT 2nd Phone Ext.

("Ext." displays) Extension for the second
contact's phone number.

PHONE3 3rd Phone Third contact's phone number.

PHONE3_EXT 3rd Phone Ext.

("Ext." displays) Extension for the third contact's
phone number.

PUB_STATUS Public/Private Access level for the contact.

Values are:

1  Public
(default)
2  Private

REFER_BY Referred By Description of the contact's
referral source.

SALUTATION Salutation Contact's letter salutation or
greeting name.

SPOUSE Spouse Name of the contact's spouse.

STATE State State in the contact's address.

TICKERSYM Ticker Symbol Company's stock ticker symbol
for ACT! 4.0 or later databases
only.

TITLE Title Contact's title.

TITLE2 2nd Title Second contact's title.

TITLE3 3rd Title Third contact's title.

UNIQUE_ID Unique Id Unique contact record
identification number. This field is
supplied by the system.

URL Web Site Contact's web site URL address.

USER Record Manager The Unique ID of the database
user permitted to access and
change the status of private
contacts. This field is supplied by
the system.

USER1 User 1 User-definable field 1.

USER2 User 2 User-definable field 2.

USER3 User 3 User-definable field 3.

USER4 User 4 User-definable field 4.

USER5 User 5 User-definable field 5.

USER6 User 6 User-definable field 6.

USER7 User 7 User-definable field 7.
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USER8 User 8 User-definable field 8.

USER9 User 9 User-definable field 9.

USER10 User 10 User-definable field 10.

USER11 User 11 User-definable field 11.

USER12 User 12 User-definable field 12.

USER13 User 13 User-definable field 13.

USER14 User 14 User-definable field 14.

USER15 User 15 User-definable field 15.

ZIP Zip Zip code in the contact's
address.

4.2.4 Outlook and ACT! Fields

All Outlook Fields that are write/read are available to be overwritten. Fields that are Read-Only in
Outlook cannot be overwritten by ACT-To-Outlook Professional 2006 Edition. The fields below cannot
be overwritten by the conversion.

Fields that cannot be overwritten in Outlook
Actions
Application
Class
CompanyLastFirstNoSpace
CompanyLastFirstSpaceOnly
ConversationIndex
ConversationTopic
CreationTime
EmailDisplayName
EmailEntryID
Email2DisplayName

Email2EntryID
Email3DisplayName
Email3EntryID
EntryID
FormDescription
FullNameAndCompany
GetInspector
LastFirstAndSuffix
LastFirstNoSpace
LastFirstNoSpaceCompany
LastFirstSpaceOnly

LastFirstSpaceOnlyCompany
LastModificationTime
LastNameAndFirstName
Links
OutlookInternalVersion
OutlookVersion
Parent
Saved
Session
Size

Street Address Fields and Phone Numbers
Street Address fields are handled differently between ACT and Outlook. In ACT, the street address
fields are defined as Address1, Adress2 and so on. In Outlook, the street address fields are one field
separated by returns (carriage-return-line-feed).
Hence, ACT-To-Outlook Professional 2006 Edition provides users with the option to merge address
and phone number fields to be Outlook Friendly.
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ACT! Representation Outlook Representation

Field Example Field Example

Contact's Street Address Outlook Street Address

Address 1 1892 Washington BusinessAddressStreet 1892 Washington
Apartment A
Suite 202

Address 2 Apartment A

Address 3 Suite 202

Contact's Home Address Outlook Street Address

Alt Address 1 1892 Washington HomeAddressStreet 1892 Washington
Apartment A
Suite 202

Alt Address 2 Apartment A, Suite 202

Contact's Phone Number Outlook Phone Number

Phone 408-773-9380 BusinessTelephone
Number

408-773-9380 Ext. 2343

Ext 2343

All other phone numbers in ACT! are dealt with in the same way i.e. the extension is applied directly
to the phone number, unless the merge fields feature is not set.

4.2.5 Email Addresses

An ACT! contact can have an unlimited number of Email Addresses while Outlook only allows 3
"standard" email addresses, namely Email1Address, Email2Address, Email3Address. ACT-To-Outlook
converts email addresses using the following logic:

· The ACT! default (or Primary) email address gets converted to Email1Address
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4.3 Conversion Preview

The contact preview screen comes up when you press the Convert button. The ACT! users  listed on
the ACT! Username list are the users that will be processed for the database conversion. These are
users that have the check mark in the main screen. Pressing the Process Users will start the
conversion of the contacts from ACT! to Outlook.
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4.4 Contact Selection Viewing

The contact selection viewing form comes up when you press the View button on the main screen. It's
objective is to provide a listing of the contacts that will be selected for conversion once the Process
Users button in the preview screen is pressed.

Dealing with Large Databases
The objective of the Contact Selection Viewing is to provide users with a list of the contacts that will be
converted for a particular user. If you have Convert All enabled, all the contacts will be listed on the
database. However, if you have over 20000 contacts in the database, the listing will take awhile. You
can press on the Stop button to stop the listing and still see the front end of the contact list.

Contact List with no contact name and company name
In many ACT! databases, there are a lot of empty records and these records will display at the
beginning of the list. Scroll down the list and you'll see the real contact records.
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4.5 Tools Menu

· Outlook Clean - Quick and easy way to remove items from the Outlook folders.
· Administration - Change current admin settings.
· Create Outlook Export Tree

4.5.1 Outlook Clean

The Outlook Clean option in the Tools Menu will DELETE all items from the folders that have been
setup for the individual users. Only the users that are check mark'ed are considered for cleaning.

4.5.2 Administration

The Administration Menu
When the administration menu is clicked, you get the options below:

Change Administration Login
This from is used to change the
administration login details.
Remember, whatever username
you change the login to be, that
username has to have privilege
to access the details required by
the software. It is recommended
that you use a login profile with
administration privileges.
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Change Outlook Profile Login
This screen enabled the user to
change the profile settings of the
main login.

To properly test the profile login,
make sure that Outlook is
closed and that there is no
Outlook process running in the
background.

Refresh Users
If you add/remove users from the ACT! database, the refresh users option goes through the ACT!
database and refreshes all the users that exist in it. If the user already exists in ACT-To-Outlook
Professional, nothing is done. However, if it is a new user, it is added to the user list.

Add User Licenses
This option allows you to add user licenses to your current set of users.

4.5.3 Create Outlook Export Tree

This tool provides for a quick way to setup a whole Outlook Folder tree with a shared contact folder
and each user with his/hers individual Calendar and Tasks folder. In the example above, using the
demo database provided with ACT!, the corresponding Outlook tree is shown below. What would
otherwise take hours to setup, only takes a matter of seconds.

If you don't like any of the names provided, you can simply click twice on the name and then edit it to
your desired nomenclature.
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5 Getting Started

5.1 Step 0 - Activating your product

When you download any of ACT-To-Outlook.com's products, you receive our demo version of the
product. In order to enable this demo, you must activate it.

The License Number
When you purchase, you receive an unique license number from us in the form of a 17-digit number,
for example: 49015-2822-1273-1966 . This number has to be entered into the Registration->License
Activation menu in order for the product to operate unencumbered.

Registration->License Activation

The License Activation Option instructs the software to activate using the internet. This option
instructs it to authenticate with our license server and then activate the product. When selected, you
get the screen below:

When the register button is pressed, the software will activate. If you are running a firewall or if there
are any connectivity issues that prevent the software from activating, then use the Manual License
Activation

Registration->Manual License Activation

The Manual License Activation should be used when the automated, internet-based license
activation fails. The user is taken to a web page at ACT-To-Outlook.com and then an email is sent to
the user with instructions on how to register the software. For instructions on activating the software
using the email we send, click here.

5.2 Step 1 - Opening the ACT! database

When the software is first run, you get a screen with Empty fields as shown below.
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When you click on the browse button, you are provided with the list of available databases. In this
case, we select ACT6demo.dbf as the database and we click on the open button.

If your database is password protected and/or you have multiple users defined in the database, the
username and password screen is presented.
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Here, you must enter the username and password for a user that has Administration privileges on
the database. If the user does not have Administration privileges, you may not be able to access
other user's data that is required for transfer.

When you have successfully logged in to the database the following happens:
1. The database gets listed on the ACT! Database Field
2. The user you used (in our case, Chris Huffman) is then declared administrator. If you made a

mistake and wish to change the administrator, go to the Tools->Administration menu. Click
here if you wish to see how to change the administrator login.

3. All users defined in the database are listed on the ACT! Username List.
4. All fields in the ACT! Database are listed in the Field Mapping tab.
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Quick Custom Field Mapping
You can quickly create a custom field map by pressing the Quick Custom Field button on the field
mapping Tab.

5.3 Step 2 - Set the Outlook Profile Name

If you use multiple Outlook profiles, you can only change them in the Administration option accessible
from the Tools menu.
It is important to set the Outlook profile if you intend to run the software without Outlook being open.
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Select the Tools->Administration->Change Outlook Profile Login in order to set the Outlook profile
name and password (if necessary).

5.4 Step 3 - Set the General Settings

Most of the defaults in the general settings work when you first convert the database. However, if you
wish to re-map fields from ACT! to Outlook and so on, this is where it is done before the conversion
takes place.
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5.5 Step 4 - Enable and Set the Individual ACT! Users

This is where you enable/disable which users get converted into the corresponding Outlook Folders. A
few things:

· Even if a user is excluded from the conversion, the History/Notes items owned by that user are still
converted to the contact body text with the corresponding user ownership.

· For users that intend to share a contact folder, all the Outlook Contact Folders must be the same.
You time purposes, you should only convert 1 folder and then setup the contact filters for the other
users not to convert.

· If you are converting more than 16K contacts into Outlook 2000 and 2002, the conversion will fail
due to folder limitation of 16K. That is NOT the case with Outlook 2003.

Select the contact filter for the user

Each user has 5 primary filtering options to convert contacts:
1. Convert All: All the contacts are converted
2. Convert Calendar: Only contacts that have calendar items (calls, meetings or todo's) that are

not cleared are selected.
3. Convert Group: Convert only a selected group and/or subgroups.
4. Do Not Convert Contacts: No contacts are converted for this user.
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For more information on Contact Conversion Filters, click here.

Include Private ACT! Contacts. When this option is set, private contacts are included in the
conversion. If unset, no contacts flagged as private are converted to the Outlook Folder.
Match ACT! Record Manager Field for Contacts and Activities. Each ACT! Contact and
Activity has a Record Manager Field. When set, only records that have a record manager ID equal
to the ACT! User being converted are brought over.

Activities Options
The activities options, by default, come almost all enabled as listed below:

The company addition to the subject line may be added is required.

5.6 Step 5 - Running the Conversion

To run the Conversion, click on the convert button.

When this button is clicked, you get a list of the enabled contacts that you with to convert:
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Click on process Users and the conversion status screen pops up.

The users will all be converted as long as the STOP icon is not pressed. When the conversion is done,
the stop icon disappears and the conversion is done.
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6 Examples

When you open ACT-To-Outlook Professional, you get the screen shown above. The ACT! users
defined in the ACT! database are listed on the left column, the ACT! Username column. Each user
listed in the user settings tab has its own, customizable set of settings.

6.1 Example: Each User with their own set of folders

In this case, you want to have a fully independent set of contacts for each user. In this case, ALL
contacts are transferred over.
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ACT! Multi-User Database Outlook Folders

User John: John's Outlook
Folders:

Contact Folder
Calendar Folder
Tasks Folder

User Paul: Paul's Outlook
Folders:

Contact Folder
Calendar Folder
Tasks Folder

.

.

.
User LastUser: LastUser's Outlook

Folders:
Contact Folder
Calendar Folder
Tasks Folder

Each user has it's own set of Outlook Folders that will contain ALL the contacts in the database.

Step 1: Create a contact, calendar and tasks folder in Outlook for each user defined in ACT!
Step 2: Click on the user in ACT! and then select their appropriate folders:

Step 3: Select the contact filter for this user.
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Step 4: Select the Activities to convert from the Activities Options

After the activities options are selected, press convert and all the enabled (checked) contacts are
selected for processing and processed.

Modification 1
If you want only the contacts that belong to the user (record manager is the same as the user),
check the Match ACT! Record Manager Field for Contacts and Activities and only those items will
transferred over.

6.2 Example: Users share a common Outlook contact folder.

In this example, all users share 1 common Outlook folder (in our case it is John's) but have their own
independent Calendar and Tasks Outlook folders.

ACT! Multi-User Database Outlook Folders

User Johnnyt: Johnnyt's Outlook
Folders:

johnnyt Contact
Folder
Calendar Folder
Tasks Folder

User Allison: Paul's Outlook
Folders:

johnnyt Contact
Folder
Paul's Calendar
Folder
Paul's Tasks Folder

.

.

.
User Chris: LastUser's Outlook

Folders:
johnnyt Contact
Folder
LastUser's Calendar
Folder
LastUser's Tasks
Folder

Each user has it's own set of Outlook Folders that will contain ALL the contacts in the database.

Step 1: Click on the primary user/contact (in our case, Johnnyt) in ACT! and then select their
appropriate folders:
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Step 2: Select the contact filter for this user.

Step 3: Set all the Activities Options.
Step 4: Setup the other contacts to point to the primary contact's Outlook folder: Make sure that you
select the Calendar and Tasks folder to process.

Step 5: Set the contact filter processing to be "Do Not Convert Contacts". This stops the repeat
processing of the same contact database.

Step 6: Repeat step 4 and 5 until all users have been setup.
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Modification for Calendar and Tasks.
You can do the above and share both Calendar and Tasks Outlook folders.

6.3 Example: Transfer contacts and activities to common folders
(copy)

In some instances, you may want to transfer a whole ACT!'s database contacts and all the Todo's,
Calls, and Appointments to a set of common Outlook folders, as shown below:For some users, you
may want to transfer Activities without necessarily create contacts in an Outlook folder. The
attractiveness here is to have a common contact database in Outlook that everybody shares and
everyone's activities in one common area.

ACT! Multi-User Database Outlook Folders

User Johnnyt:
User Allison:
User Chris:

Common Contact
Folder
Common Calendar
Folder
Common Tasks
Folder

To do this, you do the following:
1. Create the common folders in Outlook
2. Link the users to the common folders

3. Do this to all the users.
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4. Once the folders have been set, set the ACT! Contact Filter for 1 user to be Convert ALL and for
all the other users set it to not convert the contacts. Otherwise you'll be double converting the
database's contacts to the same contact folder without any real benefit.

5. On the Activities tab, make sure that you have the Add Owner checked. This instructs the
software to add the name of the owner of the activity to the activity subject line.

Results: The names of the users (owners) of the activities is listed on the actual activities and they
are linked to the common contact database. See below:
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6.4 Example: Transfer activities only to common folders

In some instances, you may want to transfer a whole ACT!'s database contacts and all the Todo's,
Calls, and Appointments to a set of common Outlook folders without having to transfer the contact
data. These type of activities are called Independent Activities. Basically, these are activities that in
Outlook are not related to any Outlook Contact. You can read the data in the activity but it is not
connected to any Outlook contact. These folders can be assigned to each ACT! user or shared by
ACT! users.

ACT! Multi-User Database Outlook Folders

User Johnnyt:
User Allison:
User Chris:

Common Calendar
Folder
Common Tasks
Folder

Independent Calendar and Tasks items are created every time the software fails to connect to
the Contact folder. If the Contact folder is moved or deleted or rendered invalid, ACT-To-Outlook
Professional will create independent Calendar and Tasks items. Hence, the key here is to render the
contact folder empty or invalid.

For example, below, we want to clear Mellisa Pearce's link to Allison's Contact Folder.
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To clear the link,
1. Click on the folder selection
2. Select the Cancel button
3. Select Yes to clear the Outlook entry from the User Settings.

One thing: Only when the last user has cleared the folder link will the relevant Index maintained by the
software be cleared. This means, for example, if you have 3 users pointing to the same Outlook folder,
clearing one will not reset the item index for that folder. Only when the last user is disconnected, is the
index reset.

Visual Description on how to clear the Outlook Folder Link
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6.5 Using The Contact Filters

The contact filters are specific for each user. The users are processed by the settings in their contact
filters in the order below:

1. Convert All
2. Convert Calendar
3. Convert Group
4. Do not Convert.

Wise usage of the filter configurations will enable you to reduce processing time when converting data.
Just a couple of tips:

· If all users share one contact folder, you just need to do 1 Convert All. You can set all the
subsequent user contact filters to Do Not Convert. Make sure, however, that the user that does
the Convert All is enabled (check marked).

· Convert All and Convert Query are the fastest conversion modes. Calendar and Group will always
be slower for the same number of contacts.

· No conversion optimization is done for the first time a conversion is done. However, subsequent
conversions are significantly faster, in some cases about 2000% faster.

6.6 Empty Contact Names

You will receive the screen below if a contact that has no name is encountered. Outlook establishes
the basis for all task, calendar, and journal entries via a linking system on the existence of a valid
name i.e. a name other than empty. Hence, ACT-To-Outlook Professional 2006 Edition checks
whether first and last name are set for the contact. When these fields result in empty, the "No name for
this contact" dialog appears.

When this dialog appears, you are provided with the contact
details via the roll down list and you can take the following
actions:

1. You can ignore this contact. The software continues
to process the next contact

2. You can set the name for the contact to be set in
Outlook. Enter the name in the name box to enter the
new name. You can look through the list and
determine what the name of the contact is.

3. Apply Button. Continue processing. Remember, if the
blank name contact has any activities, todo's,
calendar, or journal entries, they will not be linked to
the contact

4. Cancel Conversion Button. Cancel the conversion of
the ACT! Database into Outlook.

5. Do not ask again. Continue processing this contact
and in the event of another contact being blank
named, continue processing.
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7 Tips and Tricks

7.1 Converting Addresses

In Outlook, street addresses are represented differently than in ACT! In ACT!, street addresses are 3
fields while in Outlook it is only 1 field. ACT-To-Outlook Professional 2006 Edition provides users with
the capability to Merge all three addresses into 1 Outlook Field. In addition, it will also convert the 2
fields that ACT! has for representation of Home Address into 1 Outlook Field.

To enable this feature, click on the "Merge Address 1, 2 and 3 into one string" option in the conversion
options.

Note: You must enable Address 1 and Home Address 1 to be converted in the Contact Field Mappings.
Otherwise, ACT-To-Outlook Professional 2006 Edition will ignore the Address conversions.

7.2 Limitations

Outlook Folder Limitation
Outlook 2003 limits the number of entries for folders to 64K. Hence, do not add more that 12K items to
an Outlook folder.

Memory Limitations
ACT-To-Outlook Professional 2006 Edition may run out of memory under the following circumstances:

· If you enable History Recording to the Contact Body Text and you have a large number of history
records for that contact. This occurs primarily when you are converting My Records or a record
that has thousands of history entries. ACT-To-Outlook Professional 2006 Edition will save the
history into a local temporary file and then read that file to the Outlook contact record. However, if
the file is too large, Outlook will run out of memory and the history can't be converted.

Solution: Either clean up the history in ACT! and erase all old records or set the date filter in ACT-
To-Outlook Professional 2006 Edition to only pick Activity items after a certain date.

7.3 Errors

ACT-To-Outlook Professional 2006 Edition errors are generally followed by a code and a string that
explains the error. From past experience, ACT-To-Outlook Professional 2006 Edition generates very
few errors once it is setup. The product has been out for over 2 years and we believe that most bugs
have either been found or exterminated (literally). Ever so often we get calls re. errors and here is a list
of actions you can take to resolve the error:

Errors with retrieving Outlook Folders
This error occurs when you've changed folders in Outlook and ACT-To-Outlook Pro cannot find the
default folder. The message is in general:

"ACT-To-Outlook Professional 2006 Edition: Error on retrieving Tasks Folder"
"ACT-To-Outlook Professional 2006 Edition: Error on retrieving Contacts Folder"
"ACT-To-Outlook Professional 2006 Edition: Error on retrieving Appointments/Calendar Folder"

Solution 1
1. Click on the Outlook Folders Tab
2. Click on the Pick Folder button for each Outlook Folder and select the corresponding Outlook

folder.
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3. Do this for each folder.

Solution 2
1. Click on File->Retrieve Default Outlook Folders. This will retrieve the Outlook Default Folders

into the folders in question and reset them to the default.

Out of Memory Error of Vbox Error
This can occur if you are converting many history items into the contact's body text (the part in Outlook
contact where you can write). There are various solutions problem:

1. Disable converting history.
2. Reduce the amount of history items that you convert.
3. Clean up your database of old history records

This is a limitation in Outlook when you put large amounts of text into the contact's body.

Note: This section is new and we will be expanding it re. any issues with errors with ACT-To-Outlook
Professional. Check our online help for any additions and solutions before you contact ACT-To-
Outlook.com.
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8 Known Problems With ACT!

Corrupt ACT! Database
Removal of Users from an ACT! database will corrupt your database and result in fields that
cannot be transferred to Outlook.
This is the most common issue we have with ACT! when using our product. We've had users that
remove any additional users from their database only to see the database become corrupt as a
result. Don't do it!
In general, you'll see strange errors popup and what used to work just fine no longer works.
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